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StudioLine Photo Basic 4
StudioLine Photo Classic 4
StudioLine Photo Pro 4
StudioLine Web Designer 4

Online Registration

Register here after purchasing StudioLine. You will be notified of updates, receive complimentary web
space and have access to our product support.

http://www.studioline.net/en/support/registration/

How to Reach Us

Visit our discussion forums 24 hours a day to trade your experiences, discuss product related issues
and get answers on the product usage. We usually respond to posts within a business day:

http://talk.studioline.net/

Updates, news and related products can be found on the product web site:

http://www.StudioLine.biz/

Log Files

In the “Help” menu, you can choose the 'Contact H&M's Customer Service' tab. This prepares an
Email that contains the log files created by StudioLine on any given day. These Log files provide the
details of numerous StudioLine internal functioning and steps that when analyzed, can be extremely
helpful in finding the pathway to a solution.

Should StudioLine not work as expected, please choose this menu item to send us an email. Please do
not forget to include a description of the problem as well.
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StudioLine Photo Basic 4

With StudioLine Photo Basic 4 you get a software package that includes many
functions of StudioLine Photo Classic 4, including dual-monitor support and
automatic updates. StudioLine Photo Basic is the free entry software for private
use!

You also can download the online help as a PDF file:
StudioLine Photo Basic 4
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System Requirements

Microsoft® Windows® 10 / 8 / 7 / Vista
Processor with a minimum of 1.6 GHz, higher recommended
2 GB RAM, more recommended
150 MB disk space for programs (allow extra space for data)
24 bit graphics adapter with monitor resolution of 1024 x 768 pixels

Supported Languages

English / German / French / Italian / Spanish

Supported Browsers

Recommended browsers for viewing web galleries created with StudioLine:

Internet Explorer, Version 7 and higher
Chrome
Firefox
Opera
Safari

Using MediaCenter in StudioLine requires Internet Explorer Version 7 or higher.

Names of products, services and companies are trademarks of their respective owners.
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Installation Guide

During Setup, StudioLine will adhere to the language settings of the operating system. Once installed,
StudioLine offers a number of supported languages. To choose a language, select “Language” from
the “Preferences” menu. The final system language will be determined when you enter the product
activation code.

Installing from the Internet

Download the current version of StudioLine Photo Basic from our website.

If prompted, click “Run” or “Save”. If you have saved the installer, double-click the installer file to
start the installation process.

Setup the Data Directory

On first start after the installation, you will be prompted to enter a path where StudioLine stores your
data.

If a Data Directory already exists on your computer (e.g. from an older installation), you can click on
the “Browse” button and select the appropriate path. StudioLine then will use this path and convert
the data to the most current version if necessary.
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Product Activation Code

After installation you'll be able to test all functions of StudioLine for 30 days. To continue using
StudioLine Photo Basic as a home user at no cost, simply request the complimentary activation
code. You will receive the product activation code per email. Print this email and keep it in a safe
place for future reference. You will need it whenever you install StudioLine in the future.

StudioLine Photo Basic is only “Freeware” for personal use. Business or other commercial use
requires purchase of a license.

How Do I Find the Activation Code Inside the Program?

Once you have successfully installed and activated StudioLine, the product activation key will be
found under the menu item “About StudioLine” of the menu “Help”.
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Image Archive

1 Menu Bar Access menus divided by commonly used groupings.

2 Mode Selector
Switch here between the modes:
Photo: Image Archive.
Web: Page Editor, Layout, and Layout Templates.

3 Button Toolbar Quick access to commonly used functions, depending of the current mode:
Image Archive or Page Editor.

4 Tools Menu Bar Quick access to commonly used functions, depending of the current mode:
Image Archive or Page Editor.

5 Bottom Toolbar One-click access to tasks frequently performed.

6 Navigation Pane Mode-dependant: in Image Archive it displays folders of images, in all other
modes it displays the list of web galleries and the folders that contain them.

7 Image Archive or
Page Pane

Mode-dependant: In Image Archive displays all images in a folder in
thumbnail view with descriptors. In other modes it displays the page
currently being worked on.

8 Edit Pane

Via tabs at the top of this multi-use bar, you can navigate to one of three
areas:
Edit: a 'container' for all image tools that have been opened. This area
prevents the tools from blocking your view of the image thumbnails;
Describe: this area allows you to view and input detailed image descriptors
including Exif, location-based, IPTC/NAA and other data.

9 Resizing Border Click and drag it to change the border between the Navigation or Edit panel
and Image/Page panel.

10 Enlarge Pane
Button Allows you to expand the Image Archive/Page Pane for more workspace.

11 Path History A dropdown menu displays the most recently navigated positions.
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12 Quick Search Allows you to quickly search for images in the Image Archive or text on a
page.

13 Recycle Bin Delete images, image tool settings, descriptors, and web galleries.

14 Size Selector
Set the display size of thumbnails. For more options with regard to how you
view your Image Archive/Page Pane, go to Display Options under the View
menu bar, or right-click in the Image Archive Pane for the context menu.

The image archive is a key productivity feature of StudioLine. Instead of a web master having to keep
track of various derivatives of the same image, StudioLine will centrally maintain picture originals in
its database of images. A folder structure and powerful search engine provide for easy retrieval and
reuse.

Original image corrections, such as cropping, proper alignment and color adjustments need only be
performed once. When an image is placed and customized on a web page, the image archive original
remains intact. Name, descriptions and other information carry over from the archive to any
occurrences on all sites.

Image Archive Directories

The Image Archive is on StudioLine Data Directory on your workstation's hard drive, and includes the
directories “Database”, “Images”, and “Cache”. In the Database directory you find the databank files
and other files that are necessary for Databank administration. Depending on what you selected for
your “Image Archive Copy Preferences”, images are stored in either the Image Directory or externally.
The Cache directory includes the thumbnails in different sizes.

Data Directory Administration

StudioLine Setup installs the program and user files in divided directories. This allows StudioLine to
administer numerous directories. Various directories can be applied after successful installation of the
Set-up program, and call it up, in order to choose another or a new directory. Once the various
directories have been created, you can easily switch between them via the Data Directory
Management window. To get to this, go to the Data Directory Management tab in the Preferences
menu. All of the data directories available are shown in the window. Currently, there is only directory
from which to choose.

If you would like to change the data directory, you will need to select it, press Activate, and ensure
that all currently open StudioLine applications are then closed, before reopening the software.

Inactivated directories can included in the list by using the “attach” button. Likewise, you can delete
directories by utilizing the “detach” button, or you can rename them with “rename”.

If you would like to switch between directories upon opening up StudioLine, be sure to check the box
“show dialog on start-up”. Directories that are housed on external drives will be shown as unavailable.

Relocation of Data Directories

To move StudioLine from an old PC to a new one, execute the following steps:
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Copy the entire StudioLine Data Directory (for example C:\StudioLine - with all the subdirectories)
onto the new PC.

Install the latest version of StudioLine on the new PC. You can download it from our webpage. Provide
the link of the just-copied directory as the new data field. After the installation, activate the software
by typing in your Product Activation Key.

Common Functions

New Folder

Give a name for the new folder. If you have chosen this from the File menu, you will only asked to
provide the new name.

The following options are only available, when you use the New Folder function in the Album pane or
when you right-click on a folder:

If the Open new folder box checked, the newly created folder is opened.
If the Set descriptor defaults for new images is checked, then you can ascribe the images in the
new folder with all of the default descriptors.

Rename Folder

In the Image Archive, to change the name of folders in your Albums, click on the Rename tab under
the File menu. Enter in the new name and click ok in the window that opens up. Alternatively, you can
right-click on the selected object in the left-hand navigation pane and select Rename from the context
menu.

Choose Color

The “Choose Color” window lets you pick up and set any color you want to use for the various
functions, like font color, lonk color, colorize an image, etc.

Old / New
Shows the current active color and the newly selected color.

Note: A rainbow palette indicates that there is not one specific color that applies, for example a
selected text that uses more than one color.

Saturation / Brightness
The Saturation/Brightness of your color choice is changed by dragging the circular color picker in the
color selection square. Horizontal movement changes saturation, vertical movement brightness.

Hue
The hue changes are achieved by moving the pointed hue pick handle up or down along the rainbow
colored strip.



2016/02/08 11:06 9/71 StudioLine Photo Basic 4 - English

StudioLine Help - http://help.studioline.net/

Red, Green, Blue
Red, Green, Blue indicates the currently active RGB-values. You can enter a specific number to attain
the exact color needed.

Color Box
Color Box stores a color for quick finding later. Simply drag the “Copy” button to one of the empty
color compartments. To use such a stored color simply click on it and it will become the new active
color.

Color Picker
Color Picker is a eyedropper-style color sampler that allows you to pick up a color from any desired
part of your monitor display.

Pick Area
Pick Area allows you to set the size of the color collection area that the Color Picker pipette will
sample. An average RGB-value is calculated.
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Map View

StudioLine can display images that have been tagged with locations, called Geotagging. You can link
GPS data to images by location or Geotagging in StudioLine. In order to do this, images loaded into
the Image Archive need to have an appropriate GPS log file in the GPX- or NMEA-0183 format. This is
the same file format used by Navigation devices.

To open the Map View, simply click on the “Map” button in the Button Bar. The Image Archive pane
displays all of the images in your selected folder as thumbnails in a left-hand panel, with a Google
map on the right. Images in your folder that are already Geotagged will have a small icon in the
lower-left hand side of the image. The Google map in the right-hand pane will automatically display
the image's position on the map and mark it with a blue arrow.

If you have tagged your image, you can view the position on Google Maps by clicking on the Geotag
button below the image in Image Archive. This will launch the Map View and the image's location will
be displayed in Google maps on the right.

For images that need to be Geotagged, simply type in the name of the location in the menu bar, and
the Google map will automatically position itself there. You can fine tune the location by zooming in
and out on the map and using the cross-hair to specify exactly where the location should be marked.

Once you have found your location on the map, and positioned the cross-hair exactly on the intended
place, then you can use the 'apply position' button to Geotag the image. All the images currently
selected will then acquire that Geodata. The name for this location will be automatically acquired via
the internet (GeoNames). For images that already have GPS coordinates associated with them, but
need the name of the location to be included in the descriptor, simply click on the Retrieve Location

http://www.geonames.org
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Names button. The location names will be acquired and assigned to the image.

In order to view the Geotagged positioning of more than one image at once, click on the Optimize
Scale button and the Google map will be adjusted to include all the locations of your currently
selected photos on one map.

Importing and Exporting a Geotagged Image in .KML

KML is a file format used to display geographic data in an Earth browser such as Google Earth, Google
Maps, and Google Maps for mobile. If you want to upload your geotagged images to Google Maps or
Google Earth, simply select them in the Image Archive, right-click and go to the Geotagging/Create
KML file with thumbnails. A .kml file is then generated that allows you to upload the your image to any
of these commerical programs for viewing online. This is particularly useful if you want to create a
web gallery that indicates the location where the image was created on a map.

You can also import .kml data and images from third parties by going to the Geotagging menu and
selecting Import KML file.
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Slide Show

Select all images to be included in your slide show and follow this Menu Bar path: “View” → “Slide
Show.”

The slide show opens in full-screen mode and displays the first image. Use your right arrow button on
your keyboard to advance the show. Alternatively you can operate and make changes to your slide
show by right-clicking on the mouse for a context menu once you are in slide show mode. In the
context menu itself are options to navigate forward and backward and make other basic changes to
the Slide Show.

If you would like to operate the slide show from a control bar, click on the Show Control Buttons
and the bar below will appear. You can move it around freely.

Click the VCR-style “Start” button to start the slideshow, or click the “Next Picture” button (right or
left) to display the selected images manually, one at a time.

The rotate as well as the delete buttons are convenient when you are viewing your images for the
first time.

For more advanced settings go to the “Slide Show Settings” window. This is accessed via a button on
the control bar or in the context menu. You can even change settings while the slide show is in
progress. You can specify the time interval between images or change the descriptor text. To add
what text you would like to see, click the button to the right of the “Show Descriptors” field. This
opens the “Text” tool to choose a descriptor and define its on-screen location and presentation.

“Fading Effects” allows you to chose the fade style between your images, and also the fading
duration. You can also choose a Background color and Background music through each of those
respective settings.

The “Content” setting lets you display the selected images only, or allows you to include other images
in that folder and its subfolders. The Order setting allows you to specify the order in which images
appear.

From the Image Archive, the slide show itself can be started by right-clicking on a thumbnail and
selecting Slide Show from the context menu (or “Shift + Z” keyboard shortcut).
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The Page Editor

To edit web galleries, click on “Web” in the Main Tool bar. This opens the most recent opened web
gallery.

At the right of the window you see the “Edit” and “Describe” bar, just like in the Image Archive. In
Page Editor mode, modifications in these panes only take effect on selected objects on the currently
opened page. This way you can change the descriptors or image tool settings for your needs on this
web gallery.

Background

Open the Page menu via the Menu Bar to access the Background options, right-click on the
background portion of a page to access the context menu and choose Background. Either choose a
solid color or drag an image to the Background panel to create a plain image or tiled background.

With the option “Tile Background Image” you can choose between regular tiling, horizonal or vertical
tiling or whether you just prefer a single image as your background.

The background settings cannot be completely deleted. Every page must at least have a background
color. When you drag the copy button from the Background page to the recycle bin, the preferences
of the corresponding layouts from the page editor are carried over. In layout editor, a solid-white
background without an image is placed. (Not sure this works/I understand).

Solid Color vs. Tiled Background

A solid color background, such as white or dark grey, is frequently the aesthetically most pleasing
choice. It also makes it easy for StudioLine to share images where appropriate.

Irregular textures with little contrast also make a nice background. They should not show any visible
margins when tiled nor interfere with the readability of text.

Busy images, strong contrasts, or geometric patterns may be very distracting. They also introduce a
number of issues when graphics with transparent areas appear on a page.

Transparency and Tiled Background

When transparent images are placed on a page, some of the tiled background will show through.
However, during rendering, a cut-out of the tiled background is incorporated into the graphics file
used by the browser. If for instance, a page is given a centered orientation, the objects move in
relation to the background, when the size of the internet browser is altered. Background images with
geometric or other regular patterns (such as text or logos) may yield less suitable results.
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Positioning of Background Relative to an Object

Following are some examples of effects, dimensions, and backgrounds relative to a single object.

Here is a simple 'at' (@) character, created by using the text tool and choosing a font color. The blue
markers indicate the character’s height and width. Because a button effect and a drop shadow were
added, during the creation of the HTML data the text is converted to an image. The @ character and
shadow do not fill the entire solid rectangular area. In some areas, the white background color is
visible. Notice also that because of the drop shadow, the dimensions of the resulting image file are
now larger than the original height and width indicated by the blue markers. Now, as in this example,
when the background is used with a visible pattern, the background becomes visible within the image
as well. During the creation of the HTML dada, StudioLine unites the respective background pattern
with the graphic data, that is prepared for the browser use. As this image is moved for use in other
locations on the page, the grid pattern may not align. Thus it is illustrated that a regular, geometric
pattern (such as squares) can be a poor choice for backgrounds. An exception is when a pages'
content is composed by alignment with the upper lefthand corner.

If, however, regular pattern backgrounds are your preferred design choice, then you should:

use only non-graphical text,
use rectangular images without shadows or soft edges, or
use the Backdrop image tool to place images and text over solid color rectangles, or
place images and text on top of a non-transparent rectangular image.

Page Descriptors

This allows you to create information that can be connected to every page. In the Layout and Page
Editor modes open the window in the Page menu under the Page Descriptors tab. Several of these
descriptors control how search engines find and index the pages on your website.

Page Title - This is the title that the user's of your website will see in their web browser window and
that will be displayed by search engines. Preset value: PageName

Author - The name of the web page author. Preset value: RegisteredUser

Copyright - Copyright information

Keywords - A list of keywords and sentences that are separated by commas that are displayed on
the page, or have some bearing upon the content of the site. Keywords are used by search engines to
locate your webpages. Keep your list to a maximum of 1000 characters and enter it in lower case.

Description - Description of the page content which will be primarily used by search engines. The
description should be limited to 200 characters.

Parsing by Search Engines - This field allows you to control the kind of information a search engine
robot collects about your site. This field allows you to input META tags and attributes for your page
which will control a robot's behavior. For instance, you may not want your images, error messages, or
any media to be indexed by the robot. Or you do not want any of the links associated with a certain
page indexed. These are the types of meta-tags you can input in this field. Note that many search
engines treat these terms slightly differently.
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NOINDEX: Instructs a search engine not include a page in its index (search results).
NOFOLLOW: Instructs a search engine not to follow any of the links in a page.
NOARCHIVE: Instructs a search engine not to provide archived copies of a page to its users.
NOIMAGEINDEX: Instructs a search engine not to index images.
NOMEDIAINDEX: Instructs a robot not index any video or sound media.

Text Preferences

Under the Text tab in the Preferences menu you have options for setting your text. A panel at the top
of the window previews your selections.

Font - You can choose from a list of available fonts.

Text Width - Provides the text width for new text objects.

Size - Choose the size in pixels.

Style - Choose if you would like your text italicized, bold, or underlined.

Ignore font and size of the pasted text - Normally it is possible to paste text from the clip board
of the StudioLine website pages and layouts so that hte font, size and style remains the same.
However, if you have clicked this box in your text preferences, the characteristics of the pasted text
will be ignored. Instead, new text will be adapted to fit the characteristics of text on the page onto
which it is being pasted.
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The Text Editor

StudioLine comes complete with a multi-lingual text editor, which integrates smoothly with all popular
word processing programs. In the “Site Settings” panel under the box “Use International (Unicode)
character set (UTF-8 encoding)” and the keyboard layout settings in Windows you can control the
support for international characters sets (such as Greek and Cyrillic).

Text is added by either:

dragging the Text icon from the Tool Bar to a location on the page; or
choosing “New Text Object” from the “Text Processing” item in the Menu Bar, then clicking the
mouse to position it on the page; or
right-clicking on the page and choosing “New Text Object”;
highlighting text in another program or application and then dragging or copying/pasting it to
the StudioLine Page Editor; or
starting another version of StudioLine (found under Menu Bar item “File/New Instance”) and
dragging text from one page to the other.

The default appearance of new text is controlled by “Font Properties” under the Menu Bar item “Text
Processing”. If the “Font Properties” window is not currently open, then the font settings in the “Text
Preferences” window, (accessible via the Menu Bar item “Preferences”) apply. If the “Text Width”
window is currently open (accessible via the Menu Bar item “Text Processing”) then this controls the
initial width for the next text object.

Editing Text

After inserting a new or double-clicking an existing text object, the Text Ruler and the Text Box
become visible. Either can be dragged out of the way, if necessary. Sizing handles to the left and right
of the Text Box are available to change the column width.

Inserting, replacing, deleting, and selecting text is done using standard text processing procedures.
Use the Simple Backdrop Tool from the Image Toolbox to give the text object a background color.

The text editor is closed by clicking elsewhere on the page.

Text Editor Functions

Most text editing functions apply to a specific block of text. Be sure to highlight the text you want to
change, before you choose one of the effects buttons in the Text Editor Bar. The Font Button (bar-like
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button on the left side of the Text Tool Bar) carries on it the name of the currently active font (by
default “Arial”). Clicking on it opens the Font Properties window giving access to font and other text
characteristics. The field “Size” determines the font size of the text in points.

The functions of the other buttons on the Text Tool Bar are as follows:

Color Changes the color of the highlighted text.
Bold Changes the highlighted text to bold.
Italic Changes the highlighted text to italics.

Underline Underlines the highlighted text.
Link Links the highlighted text to a web page or a web address.

Justification Justifies the highlighted text left, right, center, or full.

Bullets

Adds a bullet symbol in front of each marked paragraph to make the text
stand apart. The text attributes for the type of bullet (such as size and color)
are set by hitting the insert key at the end of the paragraph. Choosing “bold”
or “italic” distorts the bullet symbol. The font is determined by the symbol
font.
Note: Bullets can only be used when text is left or fully justified.

Search Searches the highlighted area, the entire Text Box, or all text boxes on a given
page for specified text.

Search and
Replace

Searches for and replaces a specified text in the highlighted area, the entire
Text Box, or all text boxes on a given page.

Spell Checker Spell checks the highlighted text.
Language Assigns a language to the highlighted text for purposes of spell checking.

Paragraph Attributes

Global paragraph text attributes (such as color, bold face, or the look of the paragraph bullet) are
stored in the invisible end-of-paragraph symbol which appears as a blank space behind the last
character of each paragraph. The font of the bullet is always “Symbol” and is never underlined. To
change the text attributes of a paragraph or copy the entire paragraph, be certain to include the
invisible end-of-paragraph symbol in your selection.

Font Properties

In the Layout and Page Editor modes you have the option of specifying the text characteristics. You
access this window by going to the Text Processing menu and clicking on the Font Properties tab.
Alternatively you can reach it under the Text button in the Image Toolbox.

Font - Choose a font from the available list

Size - Choose a font size based on point size

Color - Opens the text color window. You can choose from standard colors or use the color picker to
get an exact match on a color elsewhere on your page.

Alternatively, you can use the hue dial on the right to choose a general color and then the pointer to
get the exact saturation that you are looking for.
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Style - Choose whether you would like the text to be italicized, bold or underlined.

Descriptors

Any titles, captions, and other descriptors that you added to your images can be used to dynamically
generate content in text objects.

First place at least one image with descriptors on your page. Next, open or create a text object. In the
Text Editor, click the “Insert Descriptor” button.

The panel “Insert Descriptor ” offers the available descriptors organized in the familiar groupings.
Choose a descriptor and StudioLine will insert a place holder (for example “Name”) into the text
object. Once you deselect the text object by clicking outside of it, you'll be able to view the
dynamically generated text.

If there is more than one image on a page, you need to associate a text object with a particular
image. Right-click on a deselected text object and choose “Descriptor Association” from the context
menu. Drag the circular association icon from the “Descriptor Association” panel to the image that
holds the descriptors you'd like to use in this text object.

A single text object can contain any number of descriptors, but it can only refer to one specific image.

Search

You can quickly search for text just by entering words into the “Quick Search” edit field of the Menu
bar. After pressing the “Return” key, StudioLine starts to search for the requested text in the currently
opened text editor and then in all other text object on the current page.

Alternatively you can also access them in the respective buttons found in the Text Editor menu bar.
This menu bar is visible when you choose New Text or edit text already on a page. Under the Search
tab, the following window opens up:

Search for - Enter the letters, words, or sentences for what you would like to search on a
webpage.
Search Focus - This is context sensitive depending on where you have clicked before you select
the Search tab. If you are clicked on the page background, you will only have the option of
Search All Text Objects on Page. If you are clicked inside a text object, then you additionally
have the option of Search Current Text Object. If you are clicked inside a text object and you
have a portion of the text selected, you have the above two options and the ability to search
just the Selected Text Object.

As your web page and site increases in the amount of text it encompasses, these options become
more relevant:

Match Whole Word - Click this box if you want results for only the entire word. Otherwise,
StudioLine will find all words that also include the searched word.
Match Case - Click this box if you want only search results that match the case you input.



2016/02/08 11:06 19/71 StudioLine Photo Basic 4 - English

StudioLine Help - http://help.studioline.net/

Search and Replace

The selections are the same in the this window as for Search (see above) except for the following:

Replace with - Choose the words that you would like to replace the old text with.
Replace - Replaces only the single word just found.
Replace All - Replaces all of the words that fit your search criteria.

Spell Checker

Spelling can be checked using different methods:

Global spell check: Choose “Spell Checker” found under the Menu Bar item “Text Processing”
or directly from the Text Tool Bar.
Check spelling as you type: Questionable words are marked with a wavy underscore. (This
option can be turned off).
Single check: Click right mouse button over a word. If it is not recognized, a list of alternatives
will be offered.

When a questionable word is detected, accept the suggested alternatives, correct the spelling
manually, ignore the word, or add it to a custom dictionary.

Languages

Text can be checked in a variety of languages. To associate a different language to a section of text,
select it and press the Language button on the Text Tool Bar. The default language is determined by
the operating system. Text pasted from a Word Processor retains the source language.
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StudioLine Explorer

StudioLine’s own Explorer is a key component of the software that enables many of the easy-to-use
features and advanced capabilities of the software. It functions similar to the familiar Windows
Explorer, providing access to different classes of objects: the files on your computer and local network
as well as StudioLine-internal objects.

Many StudioLine features and tools require the use of the StudioLine Explorer in order to be able to
complete the tasks. For many basic tasks, the StudioLine Explorer will automatically open to allow you
to easily complete the specific job at hand.

The StudioLine Explorer is a fundamental tool that has several iterations. The principal StudioLine
Explorer can be utilized to access the individual StudioLine Explorer functions. To access the principal
StudioLine Explorer from the File menu choose “StudioLine Explorer”. It will display the individualized
Explorers.

Once you open any of the StudioLine Explorers, whether the principal one or any of the individual
ones, an independent window is launched which can stay open while you perform other tasks. It
operates as a floating window from which you can complete specialized tasks, including drag and
drop operations between folders in different windows, no matter what page, site, or other area of the
software you are currently in.

Understanding the StudioLine Explorer window

All of the StudioLine Explorer windows employ three panes. A menu bar across the top with command
buttons. The left-hand pane allows you to navigate, access and manipulate folders, pages, or type of
Explorer windows. The right-hand content pane allows you to view, access and manipulate objects or
files in the current folder.

The main View button on the menu bar is a “T”. You can use it to toggle between different displays.
You can access a more detailed display with the alternative view button. Or an even more detailed
display possible using the following view button.

Regardless of which display view you are in, you can always increase the size of the images in the
right-hand pane but utilizing the slide in the menu bar, or the arrows to the right of it. Where
applicable, dragging an object from the right-hand content pane to the Trash Can will delete it. For a
list of other supported actions, right-click on the mouse over a folder or page to open its context
menu.
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Preferences

The appearance and function of the Image Archive Pane can be customized to suit your personal
preferences. Open the Menu Bar item “Preferences” and choose “Image Archive”. A window titled
“Image Archive” will open. It allows you to control specific aspects for each of the content views, the
color profile, and advanced settings.

Under Albums, you can control the size of and distance between thumbnail images for individual
folders. You can also reach this window by right-clicking on the background of the Image Archive
Desktop and choosing “Display Options” from the context menu.

Proxy Images

This window can be opened under Proxy Images tab in the Preferences menu.

The proxy image is a hard disk space-saving version of the original picture that has a low resolution
and quality. You can make modifications to the settings in the dialog box.
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Keyboard Shortcuts

Workspace and Global Shortcuts

F1 Request context sensitive help on the current object. If no object is
selected, then the Help Table of Contents opens.

Ctrl + S Saves current page.
Ctrl + “+” / “-“ Increases / decreases the image size.

Alt + F4 Exit program.
Tab / Shift + Tab Jumps to next or previous object on the page.

F5 Refreshes the current list in StudioLine Explorer.

Alt + Enter Displays the context menu for the selection. The context menu key on the
Windows Keyboard is also supported.

Delete Deletes the current selection.
Ctrl + A Selects all objects.

Ctrl + Mouse Click Toggles the selection. The object is either added or removed from the
selection.

Shift + Mouse Click Adds the object to the selection.
Right Mouse Click /
Shift + Right Mouse

Click
Opens the context menu for the object selected.

Ctrl + Right Mouse
Click Opens the context menu for the current selection.

Ctrl + C Copies the current selection to the system clipboard (Copy).
Ctrl + X Moves the current selection to the system clipboard (Cut).
Ctrl + V Pastes the content of the system clipboard (Paste).
Ctrl + Z Undo.
Ctrl + Y Redo.
Ctrl + J Joins / splits text objects.
Ctrl + G Toggles the display of object status icons.
Ctrl + L Locks layout objects so they can't be selected or moved accidentally.
Ctrl + P Fixes the object at its current position.
Shift + Z Opens the full screen slide show.
Ctrl + F Opens the search dialog.
Ctrl + I Opens the image toolbox.
Ctrl + T Opens the Histogram.
Ctrl + D Opens the descriptor dialog.
Ctrl + O Create copy and open with the Windows default application.

F7 Create preview.
F8 Start transfer.

Page Up / Page Down
/ Pos1 / End Scroll the workspace up / down one page, scroll to the top / end.

Arrow Keys Moves the current selection in the direction of the arrow by one pixel. Press
and hold the Shift key to move the current selection 10 pixels at a time.
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Shortcuts in the Image Archive
Ctrl + S In the Image Archive, turns on/off the magnifier.

Ctrl + ”+”/”-“ Zooms in/Zooms out.
Ctrl + O Create a copy and open with the default Windows application.

Shift + Ctrl + O Open original with the default Windows application.
Shift + Z Launches the full screen slide show.
Ctrl + F Opens the search dialog in the image archive.

Ctrl + Drag Create a Copy.
Alt + Drag Create a shortcut.

Ctrl + Arrow Left/Right The selected image is rotated counter clockwise / clockwise.

Shortcuts in the Page Editor
Ctrl + S Saves the current page in the page editor.
Ctrl + H Toggles between selected/deselected.

F7 Create preview of page/web gallery.
F8 Transfer page/web gallery to a server.

Ctrl + F Opens the dialog “Find and Replace” for text.

Shortcuts for Palettes

Esc
When used with a text field: Reverts the text field to the content it had before any
key was pressed and exits the field.
When used in a message box: Equivalent to Cancel button.

Shift + Esc Reverts the text field to the content it had before any key was pressed.
Tab / Shift +

Tab Jumps to the next or previous field.

Shortcuts for Lists
Arrow Up /Down Scroll list by one item.

Page Up / Page Down Scroll a full page.
[keyboard input] Scrolls the list to an item that starts with the input characters.

Enter In a hierarchical list, opens the next hierarchy (if supported).
Backspace In a hierarchical list, opens the previous hierarchy (where appropriate).

Shortcuts for the Text Editor
Del Deletes a character to the right of the cursor.

Ctrl + Del Deletes a word to the right of the cursor.
Backspace Deletes previous character.

Ctrl + Backspace Deletes a word to the left of the cursor.
Ins Toggles between Insert and Overwrite mode.

Home Beginning of line.
End End of line.

Ctrl + Arrow Up Beginning of paragraph.
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Ctrl + Arrow Down Beginning of next paragraph.
Ctrl + Home Beginning of first paragraph.
Ctrl + End End of last paragraph.
Ctrl + Left Beginning of previous word.

Ctrl + Right Beginning of next word.

Shift + Arrow keys Moves the cursor to the appropriate position and selects any text in
between.

Ctrl + B Bold.
Ctrl + I Italics.
Ctrl + U Underlined.

Ctrl + Shift + A Toggle case between three states: lowercase, Title Case, all caps.

Ctrl + Shift + V Pastes the content of the system clipboard without any text formats
(Paste plain text).

Ctrl + Click or Double-Click Selects the word the text cursor is on. Drag the mouse on the last click
to select additional words.

Shift + Click Selects text block between position of text cursor and position of
mouse pointer. Drag the mouse to change the text block.

Shift + Ctrl + Click Selects text block starting from the full word at the text cursor position
up to and including the word at the position of the mouse pointer.

Triple-Click Selects entire paragraph. Drag the mouse on the last click to select
additional paragraphs.
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Importing Images

To use StudioLine for your images, they need to be added to the StudioLine Image Archive. StudioLine
offers two methods for managing images:

"Copy" Mode

Images from an external source like a camera or CD are copied into the StudioLine Image Archive.
Once copied we refer to them as internal images.

Once StudioLine has created this master-copy in the Image Archive, you could decide to delete the
original image. A practical example would be the memory chip of your digital camera. After importing
photos into StudioLine, the camera’s memory chip could be erased to make room for new pictures.

Digital camera users should always operate in “Copy” mode. Some cameras may reuse the same file
names each time the memory chip is erased, for example DSCF0001.jpg. Next time you copy your
picture files to a Windows folder that already contains prior images from your camera, Windows may
encounter duplicate file names and offer to overwrite the older pictures. This may cause you to
accidentally lose irreplaceable memories. This is never an issue when you import your pictures
directly into StudioLine using the “Copy” mode, since identical file names pose no problem to
StudioLine.

The “Copy” mode is suited for all data storage media because it is the safest. External programs have
no access to the StudioLine data files. Your files can not be accidentally changed or deleted.

"Don’t Copy" Mode

The actual image resides outside of StudioLine’s Image Archive, and only references to these original
images are copied into the Image Archive. We refer to them as external images. Sometimes an
original image is located on removable media or is temporarily unavailable for other reasons,
StudioLine therefore generates a “Proxy Image” much like a thumbnail in the Image Archive. Settings
regarding proxy images are found in the “Preferences” menu.

The “Don’t Copy” mode should only be chosen if you prefer not to delete your original images from
your hard disk and can’t afford the additional disk space for StudioLine to create its master-copies. If
you chose this mode for CDs, DVDs or other removable media, especially your camera, then you may
find it inconvenient to always have to keep these media close at hand. The risk is very high that you
accidentally erase or overwrite images on such media. Again, your digital camera is a good example.
Furthermore, every time you need to create a high-resolution print or want to export the image,
StudioLine would prompt you to insert the disc or connect your camera.

It is generally recommended that you use the “Copy” mode as long as you have available disk space.
Once disk space gets sparse, StudioLine offers the offload feature for older or less frequently used
images.

Your choice of internal vs. external images has no bearing on your ability to manage, edit, and
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process your pictures with StudioLine.

You can decide how StudioLine will
manage your images in accordance
with the different types of media you
choose. Select “Image Archive Copy
Settings” from the Menu Bar
“Preferences”. (The “Image Archive
Copy Settings” window will open
automatically the first time you load
images).

In addition to setting “Copy” and “Don’t Copy” modes, you can also choose to be prompted during
each import simply by selecting the setting “Ask”. This is a good choice if you want to be able to copy
images from borrowed CDs, but not copy images from any CDs that you own.

You may change your settings at any time. Of course, this would only effect any new images still to be
added to the Image Archive. Existing images stored internally may be converted to external images at
any time, as well as external images to internal ones, as long as you still have access to your
originals.

Internally- and Externally-Stored Images

To convert internally-stored images to externally-stored ones, or vice versa, select the images and
click on one of the images with the right mouse button. Choose “Original” from the context menu and
then the option “Store Externally” or “Store Internally”.

To move an image to external storage, you will need to select a target folder.

To import an image to internal storage, you may be asked to insert the appropriate CD, DVD or other
removal media, if that’s where the original picture resides.

Importing Images Using the Load Assistant

Using the StudioLine Load Assistant saves much time and effort, because you decide before the
transfer begins which images, images with sound annotations, and movie files you actually wish to
load into your archive.
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When starting StudioLine, the Load Assistant automatically recognizes all files located in the “DCIM”
folder of an external drive (for example your camera’s memory card) the moment you connect it to
your computer.

In the image preview, all found images are displayed as thumbnail images enabling you to easily
recognize your files. Movies and sound files are presented with an icon. Using this overview, select
the files which you would like to import into StudioLine by using the following easy means:

Upon opening the Load Assistant, all files are automatically checked off for loading. To remove
individual files not wanted, simply uncheck them.

To uncheck or recheck all files, click with your right mouse button in the image preview area and
choose the appropriate command from the context menu.

You could also use the keyboard combination “Ctrl+A” to select all files, then checking off one of the
boxes under a thumbnail to set the checks for all.

Using your mouse you could alternatively drag and select a grouping of files. Clicking on individual
files while holding down the “Ctrl” key allows you to add or delete from the grouping. Once you have
made your total selection, right-click into the selection and choose “Check Selected” or as the case
may be, “Uncheck Selected”.
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On the right side of the assistant panel set the destination for the loaded images. Using “Search” you
can pick an existing folder inside the archive. You may wish to create a subfolder and have the files
loaded into it.

It is possible to rename the images while loading – if you wish, in consecutively numbered order. This
way your images have a meaningful name right from the start, while preventing future work in the
process.

Older Windows versions only allow the Load Assistant to be summoned up manually. There are two
ways to do this:

Follow the menu path: “File” → “Import” → “Load Assistant”.

Open the StudioLine Explorer under File in the Menu Bar and click, without having selected a file, on
the “Load Image” icon.

Reload Source Image

If you are in the Image Archive you can go to the Image menu and the Reload Source Image tab. This
option allows you to reload the graphic data that was originally imported into StudioLine. If available,
StudioLine searches for the data in its original position. If the files can't be found and only one image
is selected, the user is prompted to search for the files in the StudioLine Explorer - Image Archive.

This function can improve the image quality after a small piece of the image has been first cut and
then increased in size. Through the subsequent download function the original graphic files are
restored and the cut out area is saved in the highest resolution as defined by the Image Rendering
settings, found under the Preferences menu. If you are working with Kodak Photo-CD the best suited
resolution is uploaded.
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Duplicates and Shortcuts

There may be occasions when you would like to have more than one copy of the same image to work
with. StudioLine addresses this situation with two functions.

Creating Image Duplicates

To duplicate a picture, click with the right mouse button on the image and choose “Create a
Duplicate” from the context menu. The resulting duplicate is an entirely new image; you may edit this
duplicate and add unique descriptor texts free from associations to the source image.

This feature is helpful if you want to keep separate copies of different detail views or cut-out areas for
one and the same picture, or to compare the effect of different combinations of filters and settings
against the same image.

Creating Image Shortcuts

To create an image shortcut, click with the right mouse button on an image and choose “Create
Shortcut” from the context menu. Image shortcuts are recognized by the arrow icon in the bottom left
corner of the thumbnail (see below).

An image shortcut is not a separate image, but simply a placeholder object that refers back to the
original. Any editing or changes against an image shortcut will actually be applied against the original.
Editing and changes that are applied against the original will be reflected by all its shortcuts, if any.
Deleting the original image will also remove all its shortcuts from the Image Archive.

This feature is helpful if you want the same image with identical descriptions, tool and filter settings
to appear in more than one folder, for example folder: “Summer Vacation” and folder: “Animals”.
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Descriptors

Descriptors are used to store your descriptive information in different categories. Descriptors can be
printed below their images, included in emails, or added to web galleries. They also help the search
engine in grouping images that match a common theme. Additionally, they can be used for sorting.

Once you load an image into the Image Archive the descriptors “Image Name”, “Description”, and
“File Date and Time” will display below the thumbnail, some will already filled in with information from
your camera.

“Image Name” defaults to the file name of the imported picture. The same information is also stored
in the descriptor “File Name”. Often, the file name is automatically generated by digital cameras or
scanners is rather cryptic (for example “DCF0033”), which makes it entirely unsuitable as an image
title in web galleries, emails, or prints. Therefore, you should immediately give each picture a
meaningful image name. You may even give similar images the same name – there is no need to add
numbers in sequence. The descriptor “Description” is left empty, inviting you to enter your own text.
The “File Date and Time” are carried over from the creation date of the original file.

StudioLine Descriptor Types

All Descriptors

This category displays the complete set of descriptors, organized by the groups to which they belong.

To copy a descriptor to other images, click and hold the mouse button on the “Copy” button, then
drag it to other images. Alternatively, you can first press the “Ctrl” key while selecting a number of
images. Then click the “Copy” button to copy the descriptor to all selected images.

You can also left-click on the descriptor directly underneath the image to highlight it, and then right-
click to get a context menu with additional options. Once the descriptor is highlighted in the image
archive pane, you can also delete it by dragging it to the recycle bin.

A grey “Copy” button indicates that all selected images already have the same descriptor content. A
blue “Copy” button indicates that all or some images do not yet have matching content.

If the button is not checkered, this means the descriptor cannot be copied.

User Descriptors

This is the category where you can create your own descriptor tags, such as “Event” or “Holiday”, and
then fill-in your content. This will improve the success rate of locating your images later.

You can delete obsolete descriptor tags, which will also delete their content.
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System Descriptors

Some of these descriptors were created during loading. Some will have default values and others you
can also input your own information as desired.

Camera Descriptors (Exif)

Cameras will record various properties with each image, for example: camera model, exposure, f-stop
value, etc. These properties are also known as “Exif” or “Exchangeable Image File format”.

Most of the Exif content cannot be modified and appears in dark grey.

IPTC/NAA Descriptors

These are descriptors following the standards of the International Press Telecommunication Council
and the Newspaper Association of America.

For these descriptors you can supply or revise the content. If images are exported to JPEG file format,
they will include the IPTC/NAA descriptors and are available for use in other applications.

Windows Descriptors

These Descriptors can be accessed via Windows Explorer. In StudioLine, you can supply or revise the
content of these descriptors. If images are exported to JPEG file format, Windows descriptors are
included for use in other applications.
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Editing Descriptor Content

To add or edit text, simply click on the specific Descriptor Line below the image and a window
“Descriptors” will open. Alternatively, you can right click on the thumbnail picture and choose
“Descriptors” from the context menu to open the Descriptors window.

The Descriptors Panel maintains the text information and other tags associated with an image. At the
top of the window are two arrows which are navigation buttons (see below) to browse to the next or
previous image’s descriptor content. On the Image Archive Desktop, the current image associated
with the Descriptors Panel will be highlighted by a dotted border. As you scroll using the navigation
buttons in the Descriptors Panel, you can see the image highlight border advancing to the next image
on the Image Archive Desktop.

If only one image was selected, then the navigation buttons will automatically select the previous or
next image in the current folder. If more than one image was selected, then the navigation buttons
will browse to the previous or next image of the selection. The image descriptors are organized into
two categories System Groups and Forms, which can be collapsed or expanded by using the ( )
buttons in front of each category. Clicking on these group and sub-group titles lists their content in
the lower panel for you to work with.

Setting Date and Time

There are a number of scenarios in which the time stamp recorded by the camera or provided by
IPTC/NAA descriptors may not be correct.

You can correct the information for “Creation Date”, “Date (Modified)”, and the “Date (Original)” by
choosing Edit Date and Time from the Edit menu.

To update more than one image, select them beforehand. Then select the “Edit Date and Time” from
the Edit menu. A prompt will ask you whether you want to edit all the images selected to the same
setting.

The option “Edit Date/Time” is ideal for updating a single image. However, if more than one picture is
selected, all would be set to the exact same time.

The option “Adjust Date/Time” is ideal for updating a series of images and notating the individual time
each image was taken using incremental adjustments. Using this feature is helpful if you want to
correct time-zone or daylight savings time without sacrificing individual photo time differences.

Automatic Sequencing

To add a sequence number to a description, right-click the appropriate descriptor either under image
or in the descriptor panel and choose “Insert Sequence Number” from the context menu.

The panel “Sequence Number” offers several formatting options and a text preview at the bottom of
the panel. If you would like to use your sequence number for sorting purposes, make sure to choose a
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number format with leading zeroes.
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Image Titles

The display of information below each thumbnail picture can be personalized by you. To add or
remove descriptors, or to change their order, right-click on the background of the Image Archive
Desktop. Choose “Image Titles” from the context menu.

The left half of the window displays the six categories of descriptors and their content. The right half
shows the descriptors that presently appear under the thumbnail picture.

To include an additional descriptor for display, select the descriptor name on the left and click the
right arrow button to move that descriptor into the list on the right side. To exclude a descriptor from
being displayed, click the descriptor name on the right side and click the left arrow to remove it. To
change the order of appearance, click a descriptor in the right panel and use the buttons “Move
Description Up/Down by One” moving the descriptor into the desired position.

To remove the display of descriptors entirely from the Image Archive Desktop (or to enable it) simply
right click on the background of the workspace and uncheck/check the menu item “Show Image
Titles”. Alternatively you could use the keyboard combination Ctrl-H.
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Sorting According to Descriptors

To quickly sort the content of a folder by descriptors, click the “Sort” button on the toolbar or go to
“Sort” in the “View” menu.

The menu allows you to sort by the most common criteria. For each criterion you can choose
ascending or descending alphanumerical order. To sort by other or more complex criteria, choose
“Sort by Descriptors” from the menu available under Sort button. The following window opens up:

The left side lists available descriptors and the right side shows the descriptors currently in use for
sorting the images in their particular folder. Use the arrow buttons to move descriptors back and
forth.

The order of descriptors in the right half of the panel controls multi-level sorting with the top
descriptor having highest priority. For example you could list “Date (Original)” at the top and below it
“Image Name”. The resultant search would order the thumbnails by the date they were created. If
multiple images have the same creation time, they would appear in alphabetical order by Image
Name. Additionally you can choose between ascending or descending order. Sorting by date in
descending order will display the most recent images first.

You can quickly sort an entire folder or sub-folder by right-clicking on the desired destination in the
Navigation pane and selecting “Sort By/Descriptors” in the context menu.
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Image Editing

Before you can work with images, they need to be imported into the StudioLine Image Archive. The
image toolbox can be accessed via the Menu Bar item “Image”, or via the Tool Bar button: “Image
Tools”.

In StudioLine, you edit your pictures by applying image tools to them. Each image tool performs a
specific effect to a picture. For instance, there are tools to rotate and crop, adjust color tones, correct
red-eye problems, as well as various special effect filters.

For each image, StudioLine will only save the tool settings you chose and apply them before an image
is displayed or otherwise used. The master copy in the Image Archive remains unchanged. This way,
you can experiment with image tools change settings or reverse any actions – even months later.

Applying an Image Tool

Image Tools are grouped by the following three functions:

Preprocessing: These tools perform initial corrections such rotate, crop, and red-eye
correction, all of which should occur before optimizing colors, exposure, and other aspects.
Correction: These tools are used to optimize your images, for example, by correcting blurring,
improving exposure, and addressing color shifts.
Effects: The fun filters: let your creativity run wild!

To apply an image tool to a picture in the Image Archive, select one or more with a mouse click, then
choose an image tool which opens automatically in the Edit Bar. As you select more image tools, they
too will be added to the Edit Bar. If room for all image tools becomes scarce, click on the minimize
button in an Image Tool Title bar to minimize it. You can also undock an image tool by clicking the
undocking button. Click the same button to re-dock the tool to the image tools pane.

Each Image Tool has its own panel with the settings for the selected tool. Use the various controls to
achieve the desired results. StudioLine will instantly update the picture to show the effect. There is no
need to confirm your actions with an “OK” button. All tools and settings can easily be changed or
reversed at any time.

A tool can be applied to multiple images at once by selecting these images before accessing any tools
or changing settings.

Image Preprocessing Tools

One of the key features of StudioLine is the ability to apply a complete set of image optimizations to
an entire series of similar pictures. For proper image alignments, to crop unwanted borders, or to
correct unappealing red pupil discolorations in people or animals (Red Eye Removal), use the
appropriate tool from the “Preprocessing” section of the “Image Tools” panel.

Since pre-processing tools are specific to each picture and would not be copied to other images, they
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are omitted from the “Active Image Tools List”.

You have quick access to preprocessing tools like “Rotate”, “Crop” and “Red Eye Removal” from the
Bottom Bar.

Active Image Tools List

StudioLine collects all tools, filters, and their settings in a stack (the “Active Image Tools” list), which
is stored along with the unchanged original in the Image Archive. To view the active image tools list,
select an image and right click on the Active Tools Object Icon below it. This will open up the window
displaying the applied tools. Alternatively you could follow this Menu Bar path: “Image” → “Active
Image Tools.” You can also right-click on an image and choose “Active Image Tools” from its context
menu.

Changing the Processing Order

You can control the order in which tools are applied against an image by moving them around within
the Active Image Tools list. StudioLine will apply the tools top to bottom.

To illustrate the effect of different processing orders, select an image, apply the “Black & White” tool,
then the “Colorize” tool to achieve a sepia effect. This will give the picture an aged appearance. If you
reverse the sequence of the filters, then the “Black & White” filter cancels out the “Colorize” tool.

Discarding Tool Settings

To discard the effect of an image tool, simply drag the tool icon from the “Active Image Tools” list of a
particular image into the Recycle Bin in the upper right corner of the StudioLine window. You can also
right-click on any tool icon in the list and choose “Delete” from the context menu. Alternatively, if the
tool’s settings panel is currently open, you can select the particular image and drag the “Copy”
button from the top left corner of the tool’s settings panel to the Recycle Bin.

Copying Settings

There are a number of ways to copy tool settings from one image to another.

Dragging the “Copy” Button to a Single Image1.
Click on the image containing the correct image tools settings. Open the image tool you wish to
copy. Drag the “Copy” button of the image tool’s settings panel to any other image that should
inherit the identical settings.
Clicking the Copy Button2.
Click on the image containing the correct image tools settings. Open the image tool you wish to
copy. Hold down the “Ctrl” key to select additional images (be certain that the original image
remains selected). Click the “Copy” button of that image tool’s settings panel to apply the same
settings to all selected images.
Using the Active Image Tools List3.
To copy the settings of a single image tool, drag that particular tool from the Active Image Tools
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list to any target images. (Right-clicking on the Active Image Tools Status Icon below the image
will open the Active Image Tools window.) To copy all image tools, drag “Copy” button of the
Active Image Tools list onto any target images (or use the “Ctrl” key to select additional images
and then click the “Copy” button).

The “Lock” button (see below) assists in copying tools and settings to images in other folders.

Normally, the Tool panel will display the settings in effect for the currently selected image. If multiple
pictures are selected, the panel will display the settings for the image that was selected first. Clicking
the “Lock” button will turn the button red, indicating that the settings are locked. You are now free to
browse through folders and select different images – the settings will remain “frozen” on the originally
selected picture. When you have located and selected the target image(s), click the “Copy” button in
the settings panel to transfer the tool settings to them.

Histogram

The histogram displays the distribution of pixels based on brightness and frequency in your image.
The x-axis (horizontal) represents brightness ranging from black (0) to white (255). The y-axis
(vertical) represents the frequency of pixels for each particular brightness.

Ideally, an image should display an even balance of dark, mid-range, and bright pixels. Images with
an excessive number of bright pixels will appear washed out. An image too high in mid-range pixels
will appear pale. Too many dark area pixels will result in a lack of detail. The StudioLine histogram
helps with assessing the effect of image tools to attain a well balanced picture.

The histogram can be switched to different views to match various image tools. “Red/Green/Blue” is
the default view, showing the distribution of brightness combined for all color channels. You can also
select one or multiple individual color channels, or view the distribution of saturation or color. In
addition, you can choose logarithmic or linear view and overlay the chart with a grid.

To illustrate the use of the histogram, let’s take a look at the “Auto Tone Levels” tool. Select a pale or
washed-out looking image lacking contrast. Open the “Auto Tone Levels” tool from the Image
Toolbox. In the histogram at the top of the Image Tools Bar the setting should already be the default
“Red/Green/Blue” – if not, click on the fourth circular button from the left, the grey one, next to the
individual color channel buttons and the black/white “Hue” button.

The image example above nicely illustrates the lack of pixels on the right in the graph. After clicking
on “Auto-Contrast” in the “Auto Tone Levels” panel, the histogram shows how the graph is now
spread across the entire brightness range.

The balanced brightness results in a much more vibrant image. You can further move the sliders in
the “Auto Tone Levels” panel and instantly observe the result in the histogram and on the image
itself.

Editing with Third-Party Applications

You can open images in your favorite image editing tool directly from the Image Archive. Right-click
on an image, choose “Original” from the context menu, and select the menu item “Open With”. You
will see a list of applications that Windows has associated with the file type of the original image.
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There will also be an option “Choose Program …” to manually pick a specific program. Use the option
“Edit Program Shortcuts” to define shortcuts to your own program choices.

In the panel “Create New Program Shortcut” enter a shortcut name. Then use the “Browse” button to
locate the appropriate program file. Accept your choices with the “OK” buttons and you will see your
new program shortcut appear in the context menu. You can manage any existing program shortcuts
in the panel “Edit Program Shortcuts”. Click the “New” button to create another program shortcut.
Once selected, your application will launch and you can edit the picture. When done simply save the
file and close it.

When launching third-party applications from StudioLine, you should be mindful of certain facts:

Any changes made with third-party applications cannot be reversed by StudioLine. If that is a
concern, make a copy of the picture before making any changes. Right-click the image and
choose “Create Duplicate” from the context menu.
Many programs offer a “Recent Files” list in the application’s “File” menu. Do not use the
“Recent Files” list or any other third-party technique to open StudioLine-managed pictures, as
StudioLine would not register any changes made. Instead, always open these pictures by
launching the application directly from the Image Archive.
Do not close StudioLine while you are editing a StudioLine-resident image with a third-party
application. If you closed StudioLine, then do not start it again until after you have completed
your work and exited the third-party application. If your changes did not carry over into
StudioLine after restarting, right-click the image, choose “Original” from the context menu and
select the “Refresh” function.
Any changes you have made to an image with StudioLine will not show up in the third-party
application. Since StudioLine does not actually change the source image, the effects of any
filters or tools applied by StudioLine will not be available to the third-party application.
Therefore, you should limit the use of third-party applications to those effects that cannot be
accomplished with StudioLine tools. Only StudioLine tool changes can be edited and reversed at
any time.
Once you have completed your work in the third-party application, choose the normal “Save”
option in the application’s “File” menu, or the closest equivalent. “Save” will simply replace the
image on the hard disk. Do not use “Save As” or “Save as Copy” or similar advanced functions,
because StudioLine would not know where to find the updated picture.

Making Changes to Your Images Permanent

When exporting images to standard graphics files, you have the choice of including the effects of all
tools and filters performed within StudioLine (see the section “Exporting” elsewhere in this manual).
Sometimes, it may be desirable to make changes to an image permanent even though it will stay in
the Image Archive. Do this by right-clicking on an image, choosing the submenu “Image with Image
Tools Applied” and select one of the available functions:

Open Copy With
This function is equivalent to the function “Original”, “Open With”, discussed previously in the
section “Editing with Third-Party Applications”. However, this time StudioLine will first create a
copy of the selected image and its descriptors, as well as permanently incorporate the effects of
all filters and tools, including any image preprocessing. The copy will have an empty “Active
Image Tools” list because all editing has been permanently fused into the copy. All descriptors
will, however, be carried over to the copy. This copy will then be opened in the third-party
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application.
Create Copy
Here StudioLine does the same thing as in the previous function “Open Copy With”, but does
not go on to open the copy in a third-party application. As above, the copy will have an empty
“Active Image Tools” list because all tools have been processed and directly rendered into the
copy. All the descriptors will nevertheless be retained.
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Image Pre-Processing

One of the key features of StudioLine is the ability to apply a complete set of image optimizations to
an entire series of similar pictures. For proper image alignments, to crop unwanted borders, or to
correct unappealing red pupil discolorations in people or animals (Red Eye Removal), use the
appropriate tool from the “Preprocessing“ section of the “Image Toolbox” panel.

Crop and Rotate

 If you simply need to change a photo from horizontal to vertical alignment (portrait vs. landscape)
or vice versa, click the “Rotate Clockwise” or “Rotate Counter-Clockwise” button on the bottom

toolbar. The Crop and Rotate selection in the Image Toolbox opens a window with more fine-tuning
capabilities. Align the dotted line of the crop tool to a line in the image and rotate to the exact degree
quickly and effortlessly. The “Crop and Rotate” tool performs a number of tasks:

Rotate
If your camera has no orientation sensor, then you will likely need to rotates portrait images by
90°.
Mirror
This can be helpful if a slide or transparency was scanned backwards.
Crop
Use the cropping knife handles in the panel to trim off any scanning margins or to define a
better composition.
Align
If the camera was tilted or an image was not perfectly aligned in the scanner, you can place the
alignment handles along a known vertical or horizontal line in the image.
Choose Aspect Ratio
Enter the desired aspect ratio and then select the “Fix” checkbox. Now the horizontal and
vertical cropping knife handles will always move together so that the resulting cut-out area will
maintain the chosen aspect ratio.

Red-Eye Correction

 An annoying result of flash photography is red pupil discoloration in people and other pupil colors
in animals. To correct this effect use the “Red Eye Removal” preprocessing tool.

In the left “Select Area” pane, click on a discolored eye. The “Select Red Eye” pane on the right
zooms into the selected area so that you can make an accurate selection. In the right pane, click
exactly inside the discolored pupil.

StudioLine will correct the discoloration. If the result is not satisfactory, you can manually adjust the
result:

The slider “Color Tolerance” expands or reduces the area that will be corrected, in case too much or
too little of the pupil was effected.
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The slider “Adjustment Effect” controls the intensity of the color correction.

Repeat these steps for as many eyes as necessary. Each corrected eye is tagged with a number. This
way you can later pick individual eyes and make further corrections. To remove the correction for a
particular eye, choose it with the “Eye No.” control and then click the “Delete” button next to it. To
remove all red-eye corrections, drag the “Copy” button of this panel to the recycle bin.
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Image Tools

Correction

Auto Tone Levels

 Increases image contrast by optimizing the tone levels for light and dark areas of an image and
utilizing gamma correction for medium range tones. This tool is helpful for images that are over or

under exposed as well as counteracting diffuse light problems caused by a large number of lenses.

Use the sliders “Highlights and “Shadows” to manually determine a reference point for the lightest
and darkest areas of the image. Checking off “Auto-Contrast” analyzes the image to automatically
determine the optimum setting.

Use the slider “Midtones” to manually determine a reference point for the midtone range of the
image. Checking off “Auto-Tone” analyzes the image to automatically determine the optimum setting.

The sliders can also be used to further refine the automatically determined settings after both Auto-
Contrast and Auto-Tone have been checked off.

Image Enhancement

 The three sliders for “Brightness”, “Contrast”, and “Saturation”, act like those found on color
television sets. The entire color spectrum is affected.

Note: This filter changes colors linearly, which may lead to losses in the upper and lower color
ranges. Instead you may want to try the Exposure Correction tool which utilizes a more advanced
algorithm preventing this undesired effect.

Exposure Correction

 This tool offers three sliders. The “Brightness” slider targets changes of brightness in the middle
spectrum. The darkest and lightest colors receive the smallest change, which prevents the loss of

black or white areas in the image.

The “Contrast” slider allows fine-tuning of contrasts in the bright and dark areas of the image.

The “Saturation” slider utilizes a highly advanced algorithm that achieves much more balanced
results than the linear adjustments caused by the “Hue, Saturation, and Brightness” tool.

Hue, Saturation, Brightness

 The “Hue” slider of this tool window changes entire colors. If this tool is applied to only one target
color, it becomes possible to limit changes to specific color areas only. The effect of the color-
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specific saturation slider is identical with that of the saturation settings of the color setting.

The “Brightness” slider keeps the hue and saturation constant, setting it apart from other brightness
tools.

Note: A small checkmark next to a color indicates that a setting is no longer in the neutral position.

Color Tuning

 This tool is a color equalizer effective on the saturation of a specific color that appears in the
image. It is especially useful to counteract discolorations due to original poor image quality or

scanning flaws.

Note: This tool is a sub-category of the “Hue, Saturation, and Brightness” tool.

Color Balance

 Selecting a specific color from the drop-down list and using the “Cyan-Red”, “Magenta-Green”,
and “Yellow-Blue” sliders you can correctly balance a specific color channel individually.

By selecting “All Colors” use the slider “Shadows-Highlights” for fine-tuning your color selection.

The three color sliders and the brightness slider limit the effect to the color of your choice.

Color

 The “Color” tool is used for tinting or adding overall color to an image. It can be used to colorize
grey images for example. However, the correction of color problems in images is best done with

the tools “Color Tuning” or “Hue, Saturation, Brightness”.

Despeckle

 Small specks caused by dust on your scanner or on slides scanned can be removed easily with
this tool.

Sharpness

 This simple, one-slider tool increases sharpness of the entire image. It should be applied to an
image of final size; resizing undoes the effect.

Blur

 Like the sharpness tool, a simple, one-slider tool to blur the contours of your image creating an
out-of-focus look. Works well on backgrounds to create depth and to put the foreground subject
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into greater clarity. It should be applied to an image of final size; resizing undoes the effect.

Effects

Colorize

 This tool can be used to substitute specific colors of an image with other colors. The slider
“Intensity” defines the degree of colorization used in the image. If necessary, contrast will

automatically be reduced to retain the selected color.

Bicolor

 This tool applies a different color each to all dark and all light areas of an image. It is ideal to
retain the effect of an original duo-tone image. Sepia images are an example where this tool could

create a different bicolor effect, blue-green for example.

RGB Mixer

 This tool enables specific color corrections, creative color effects, and makes possible the creation
of high-quality black and white images.

Black and White

 This tool removes, on a sliding scale from 0-100%, the saturation of all colors. It differs from other
saturation tools because it corrects apparent differences in brightness; yellows become lighter

than blues.

Sepia

 Giving an image the popular sepia tint is easy with this tool. On a sliding scale it turns your image
from very light sepia to monochrome.

Scalable Backdrop

 This tool provides your image with a color background. By adjusting the background size to be
larger than the image the look of a frame is created. Adding rounded corners is also possible.

Soft Edge

 This tool softens the edges of a rectangular image by blurring them.
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Text

 The Text Tool has a special ability. It can place text into the image from direct input as well as
from descriptor text. One classic usage would be a copyright notice – taken directly from the data

base.

The upper section of the panel defines the text to be displayed. The default insert text is the system
descriptor “Copyright”. The descriptor name is always bracketed with paired percentage (%) signs to
look like this: %%descriptor%%. Descriptor values can be typed manually and bracketed so. You
can also click the “Insert” button and open the Insert Descriptor window which lets you conveniently
choose from a list of available descriptors. Of course, you will have to make certain that the
“Copyright” field or any other descriptor field actually contains text. Alternatively, you can simply
type over the default descriptor with regular text input. For multi-line text, type “\n” to force a line
break. Right-clicking in the Text field opens a contact menu via which you could alternatively access
the Insert Descriptor window as well as the option to insert special characters.

The middle section of the Text panel defines the font, style, shading, and shadow color. Using the
shadow effect is recommended for better readability when text is superimposed on an area with light
and dark background. The shadow color should be a strong contrast to the font color, for example use
a black shadow for a white text color or vice versa.

Font size remains constant for all picture sizes (thumbnail, zoomed, image viewer). The text will only
be scaled if it otherwise would not fit into the picture. To turn this feature off, uncheck the box “Scale
Text to Image Size”.

Further down you’ll find a slider. With it you can seamlessly adjust the transparency of your text in
the image. Making copyright text somewhat transparent on, let’s say an art photograph, causes less
visual disturbance, yet still remains readable. Large text or a logo sprawled across the entire image in
a watermark fashion discourages unauthorized “nabbing” of images from your web site, yet still
permits a view of the image itself.

The bottom section of the Text panel defines position and orientation. Clicking on one of the
positioning arrows correspondingly aligns your text in the image. Adjusting the direction of text to be
rotated up and down the left edge, for example, and setting edge distance can be done via the two
remaining controls.

Invert Image

 Using this tool’s slider converts your image into its negative opposite by exchanging the colors to
their RGB-complementary opposite and inverting brightness.

Note: This tool can only be effectively used on black and white negatives. Inverting color negatives
results in an orange cast.

Find Edges

 This tool finds the edges and outlines in your image and makes them increasingly more prominent
on a sliding scale of 0-100.
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Transparency

 The Transparency tool adjusts the degree of opaqueness from fully see-through (the image is not
visible at all) to fully visible (no transparency).

Note: A fully transparent image can be marked by dragging the marker frame on top of the
estimated position of the image in your workspace.

Invert Mask

 This tool inverts the transparency of an image. Opaque areas become transparent and previously
transparent areas become colored. This tool produces many interesting effects and is fun to

experiment with.

Smoked Glass

 The Smoked Glass tool is useful where a lot of text is to be superimposed on an image making it
easier to read. The tool gives a defined area in the image a colorization as well as reduced

transparency and added blurring, reminiscent of smoked glass.

Simple Backdrop

 A transparent or semi-transparent image can be given a colored background with this tool.

Emboss

 The Emboss tool adds a three-dimensional feel to your image that gives the illusion as if it had
been embossed.
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Image Search

Not only can the StudioLine search engine be used to find a specific image, but it can also be used to
collect images from various folders which match a certain theme. The Image Archive “Search”
function collects all matching images in a temporary “Search Results” folder. Searches are based on
the content of image tags (“Descriptors”). By making extensive use of descriptors and entering
detailed descriptions, you will be rewarded with much more relevant search results.

You can quickly search for images just by entering words into the “Quick Search” edit field of the
Menu bar. After pressing the “Return” key, StudioLine starts to search for the requested image in the
currently opened Image Archive folder and all subfolders.

Advanced Search

To start the advanced search, click the “Search” button in the album view of the Image Archive Pane.

In the “Search Image Archive“ panel (see below), you can enter search criteria and also limit the
search to certain descriptors and folders.

By default, the entire Image Archive will be searched. Use the folder list on the right to restrict the
search to any folder. The “Search in” field will show which folder is currently selected, or “\” for the
entire Image Archive.

The drop-down list “Include Descriptors” allows you to specify which image tags are used to find the
search argument. From the drop-down list, select “Choose…” to open the “Choose Descriptors” panel.
For an even more targeted search, check the “Advanced Search” button in the “Search Image Archive
panel.

Here you can define complex search criteria, for example, locate all pictures that mention “Portugal,”
except those that mention “Lisbon”.

Time Spans

You can use the advanced search options “Date between” or “Time between” by clicking on their
respective boxes, and using the drop down menus to define the time span. You can then chose if your
images are to be found based on their File-, Exif-, or Modification date. Choose one of the three from
the dropdown menu “use descriptor”:

Search by Exif Date
This option includes images based on the creation date as recorded by the digital camera. You’ll
quickly find sunset photos from last year’s vacation.
Search by File Date
This option includes images based on the day that they were copied to your computer. This can
be helpful for scanned and other images that lack Exif information.
Search by Modification Date
This option includes images based on the date when they were last edited. This is an excellent
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way to locate images that you recently have been working on.

Search and Replace

The panel “Search Image Archive” is also used to perform a global change against the descriptors of
several images. This feature could be used to standardize spellings or abbreviations for certain
terminology, for instance.

Type the word or phrase to be replaced into the field “Search Argument”.
Click the “Replace” checkbox. Below, type the replacement text.

The replace is “case sensitive” – the search argument you typed must use the same combination of
upper and lowercase letters as the text you are trying to replace.

Managing Your Search Results

Matching images are arranged in a temporary Image Archive folder called “Search Results”. This
special purpose folder will be discarded as soon as a different folder is opened via the album view of
the Image Archive Pane. The found images can be viewed as a slide show, printed, emailed, exported,
or used in a web gallery. You can permanently save any such search collection of theme-related
images.

First, open the StudioLine Explorer “Image Archive“ and navigate to a target folder for your
images, or create a new one. (You could also rightclick on “Image Archive” in the album view of
the Image Archive Pane and choose “New Folder” from the context menu).
Click the “Select All” button on the toolbar, or press “Ctrl+A”, to select all images in the search
results.

For the next step you have several choices:

You may simply want to retain the search result for now so that you can process them at a
more convenient time. In this case, press and hold the “Alt” key while dragging the images from
the search results to the target folder. New shortcut objects are created in the target folder, but
all pictures remain at their original locations. This also guarantees that the shortcut objects will
always use the same descriptions, filters, image tools and settings as the reference images at
their original locations. Remember, if you ever delete any of the images in their original
locations, the shortcut object will be removed as well.
If you are trying to process the search result pictures with different descriptions, filters, or tool
settings, then press and hold the “Ctrl” key while dragging the images from the search results
to the target folder. Copies of all search result picture objects are created in the target folder.
Any work performed against the image copies will not affect the pictures at their original
locations. However, thanks to the underlying StudioLine database technology, no extra disk
space is required for duplicate physical images.
If you are trying to reorganize your pictures, drag the selected images from the search results
and drop them into their target folder. The pictures will be moved from their original location to
the target folder.
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Deleting Images

To delete an image, either drag it to the Recycle Bin, located in the top right corner of the screen, or
press the “Delete” key on your keyboard. Your image will be deleted but not permanently so. Deleted
images are kept in the Recycle Bin. To view the content of the Recycle Bin, click the Recycle Bin, or
right-click and select “Open” from the context menu.

The window “Images in Recycle Bin” allows you to recover images using the “Restore” button. To
permanently remove all deleted images, click the button “Empty Recycle Bin” or right-click directly on
the Recycle Bin and select “Empty Recycle Bin” from the context menu.

When deleting an external image in StudioLine, you have the option whether you only want to delete
the information and settings of the image in the Image Archive or if you also want the actual
externally-stored graphics file to be deleted.

To safeguard against accidental deletion, images used in a web gallery cannot be placed in the
Recycle Bin. If you want to delete web gallery images, you must first delete the web gallery.
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Sending Images via Email

With StudioLine it’s easy to automatically create an email containing images you’ve selected. Select
any number of images, and select “Send Images via Email” from the “File” menu. Alternatively, you
can right-click on the selected images to open the context menu and select “Send Images via Email”.

The “Send Images via Email” window opens where you can determine the size and file format of your
image attachments.

The “Send Images via Email” window is, with the exception of a few logical differences, identical with
the already familiar “Exports Objects As...” window. Therefore the following explanations are mainly
refreshers.

Saved Settings

Here you can set and save frequently used email settings for easy recall.

Image Size

The “Image Size” drop-down menu offers a choice of standard screen and print sizes. The “Use
Original Size” option will email images in the size of the Image Archive originals. You can also use the
width and height controls to pick any custom size.

A standard or custom size you choose may not exactly fit the dimensions of the images to be emailed.
As in exporting, to safeguard against distortion or over-stretching, StudioLine will never enlarge
images beyond their original size or change their width/height proportions. Instead StudioLine uses
the “underfill” technique (discussed in the Exporting Images section). The size you choose defines a
bounding rectangle into which StudioLine will proportionally scale the images, as necessary.

The checkbox “Automatically Adjust for Orientation” will take the orientation of each image into
consideration and assign the larger specified size to the longer side of the image, and vice versa. If
you were to define a size of 640×480 pixels, then a landscape image would be exported 640 pixels
wide, while a portrait image would be 640 pixels high. Next to the two size control fields is a drop
down list with units of measurement: pixels, inches, or centimeter.

Images intended for printing or desktop publishing can thus be exported in the preferred unit of
measure. The field “DPI” will activate to let you control the print resolution.

File Format

StudioLine will propose to email images in the widely recognized JPEG format which cuts down file size
dramatically. The smaller the file size, the quicker your email will upload and send. The estimated size
of the email message appears near the bottom of the panel. Adjust the amount of compression by
adjusting the number in the field entitled “Image”. High quality (a higher number) is great for crisp
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online resolution and professional at-home printing. Low quality is really only suitable for images
where resolution is not important.

Other file formats will always use the quality of the original image. These file formats should only be
used for specific applications – such as sending images for professional quality print purposes. If you
need to send an image with transparent areas or irregular shapes, choose the TIFF or PNG file formats
and deselect the option “Colorize Transparent Areas”, as described below.

Other Options

Below the “Format” control is a list of additional options. Active options are displayed with a
checkmark. Click an option to activate or deactivate.

Apply Image Tools
If you deactivate this option, StudioLine will keep any pre-processing, but disregard other image
tools, filters, and effects that you may have used with this image. This allows you to email an
unedited version of your image.
Colorize Transparent Areas
By default, transparent areas (the “alpha channel”) will be preserved if the chosen file format
supports transparency (for example TIFF or PNG). Activate this option if you want the
transparent areas to be colored white instead. For graphics formats that don't support
transparency (for example JPEG, BMP), transparent areas will be always be colored white.
Omit Camera Specific Exif Data
StudioLine will include Exif, IPTC, and Windows tags with images if supported by the chosen
graphics file format. Select this option to omit any such camera specific information from the
emailed file.
Include Descriptors
This option will copy the system and user descriptors to the message body.

Preview

Click the “Preview” button to verify the result of your image settings before the files are sent. A
preview window will show the images based on all settings in the specified size and quality (for JPEG
images). Using the “Image Settings” drop-down menu, it's easy to find the ideal settings because the
preview will automatically refresh after any change. The toolbar allows you to browse between
images and choose a preview size A more detailed explanation of the window “Preview/Detail
Settings” is discussed in the chapter Exporting Images.

Sending

Click “OK” in the “Send Images via Email” window to send your email. If your email software is
compatible and has been defined as the default, it will automatically open and start a new message
with the selected images as attachments. Simply enter the recipient’s email address, type a message,
and send.
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Printing

Standard Print

StudioLine offers several different printing functions. The quickest way to put your images on paper is
the “Standard Print.” Select images to print, then click on the button “Print” of the Main Tool Bar. You
can also follow the Menu Bar path: “File” → “Print” → “Standard Print”.

On the left you can select one of the predefined print layouts with different image sizes and numbers
per page. Selecting a layout will update the page preview in the middle of the “Standard Print” pane.

Options

At the right of the window, you can choose one of the available printers and the number of prints per
image.

The option “Crop Images Automatically” will proportionally scale images to the chosen width and
height. If necessary, either the long or the high sides of the pictures are cropped to exactly fit the
chosen format. If the option is de-selected, then StudioLine underfills the images – the images will be
printed without cropping, but one side may be smaller than the chosen format.

When the option “Rotate Images Automatically” is checked, the images will be rotated to fit the
chosen format best. Otherwise the image will be cropped or scaled down (according to the option
“Crop Images Automatically”) to fit the chosen format.

Custom Print

Custom printing gives you complete control over all print options and offers a number of additional
functions not available in regular printing.

Print Spooler

Choose the following path from the Menu Bar path: “File” → “Print, Custom Print”.

The various images will appear listed in the “Print Spooler” panel the way they are lined up in queue
to be printed. Alternately you can open the Print Spooler directly by selecting “Print Spooler” as the
last choice in the above Menu Bar path. This way, drag images to be printed to the Print Spooler
panel. To print images or change their print settings, right-click selected images in the Print Spooler.
This will open a context menu with print and print settings functions.

The “Switch View” button on the top left in the panel toggles the image list between different display
styles. Control the print process in detail with the buttons to the right for number, size, layout of
images, and more.



2016/02/08 11:06 57/71 StudioLine Photo Basic 4 - English

StudioLine Help - http://help.studioline.net/

Number of Prints per Image

This button opens a panel to choose the number of times an individual image is printed. This can be
helpful, if various guests of an event ask for copies of different photos. Now that you have all desired
pictures in the Print Spooler select one or multiple images in the print queue, or use the keyboard
shortcut “Ctrl+A” to select all images. Click the “Number of Prints per Image” button and enter the
number of prints needed respectively. The advantage is that once you have defined the desired prints
for each image, you can start the entire print process and attend to other matters.

Print Settings

Click the Print Settings button to change the cutout area, orientation, size, or resolution of an image.

The drop-down list below the viewing area will list all popular image sizes. The cropping handles in the
image preview area will adjust automatically if the aspect ratio of the chosen picture format is
different than that of the picture itself. Any excess area is filled with a background color, which can be
chosen by clicking the “Background Color” button. If you do not want any excess area, crop the image
to a smaller cut-out area by dragging the cropping handles. Two perpendicular cropping handles will
always move proportionally to maintain the aspect ratio of the chosen picture format. To control the
cutout area, click in the center between the cropping handles. The cursor will change to a hand. Drag
the cutout in relation to the crop lines.

The option “Inverse Orientation” will swap height and width. This allows you to crop a portrait image
to landscape format, or vice versa.

Enter custom sizes in the two input fields below the size drop-down list. The cropping handles will
adjust to your input. Next to the size input fields you’ll find a drop-down list to change the unit of
measure between centimeters and inches.

Changing the image size via unit of measure or cut-out area will affect the print resolution, which is
displayed next to the unit of measurement. Print resolution is calculated as pixels per inch (ppi)
simply by dividing the pixel count of the image by the chosen physical image size. Please note that
small or severely cropped images could result in resolutions less than 100 pixels per inch, even if
StudioLine is optimizing the print output. In that case it would be best to choose a smaller image size.

If setting a specific resolution is your primary concern, then you can set a fixed print resolution
instead of choosing a size format. In the drop-down list for image sizes, choose the option “Fix
Resolution (DPI)”. A different set of options will appear below the viewing area:

The drop-down list for “DPI” automatically offers to use the image's native resolution. You can also
choose from a list of other common print resolutions or enter a custom DPI value.

Two input fields let you define the aspect ratio. The cropping handles will adjust to your input. If you
drag a single cropping handle, the aspect ratio will change accordingly. Choose the option “Fix Ratio”
to lock-in the current aspect ratio. Now, two perpendicular cropping handles will always move in
unison preserving the integrity of your chosen ratio. The option “Inverse Orientation” will swap height
and width. This allows you to crop a portrait image to landscape format, or vice versa. The resulting
print size is displayed next to the aspect ratio. “Resulting Size” is calculated in centimeters or inches,
simply by dividing the pixel count of the cropped image by the chosen DPI value.
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Any print settings that you implement on an individual image can be applied to all of your selected
images by pressing the copy button, this can save you valuable time. However, be sure to select the
images first, and then make the adjustments to the print settings.

Submitting Your Job to Print

After having set your options for each image, proceed by clicking the “Print” button. This will include
all images in the Print Spooler. To narrow down your print submission to specific images or groups of
images for printing, select them in the Print Spooler window before clicking the “Print” button.

The “Print” panel opens. Choose the printer you want to use from the dropdown list. The “Settings”
button will allow you to change options that are hardware-specific.

Two option buttons allow you to limit the print process either to specific images that were selected
from the Print Spooler – or to disregard the selection and print all images. The “Copies per Page”
option determines how often each page will be printed.

Use the helpful “Crop Marks” option if you intend to cut the printed images with the help of a ruler
and cropping blade.

To print captions below each picture, use the “Print descriptors below images” option. The panel
“Choose” opens. It operates like the “Descriptors” panel covered in the “Adding Descriptors” section,
earlier in this manual.

Click the “Print Preview” button to view the effect of any options you have chosen.

“Images per Page” can be used to limit the number of images that are printed on the same page. This
may be helpful when pages are intended for a photo album. The “Maximum Number” option will
minimize the use of expensive photo paper.

To maximally economize the use of paper, “Optimize Utilization” will change the order and orientation
of images across all pages, further keeping the number of printed pages to a minimum. This option
should be combined with the “Maximum Number” option if you plan to cut the individual images from
the printed page.

Use “Center on Page” to center the page content on the paper. It is useful for album pages since this
will produce the most aesthetically pleasing look and leave room for writing any notes around the
edges.

“Optimize Quality” will determine the exact resolution of the printer. If necessary, images are printed
slightly larger to best match the printer resolution. The results are higher-quality prints. However, the
printing process may be slowed down significantly. It may require some experimentation to determine
whether or not the slight improvements in quality warrant the increased time in printing.

Message "Image too Large"

Reason: The size of the image exceeds the size of the paper on which the image will be printed.

Click on “Scale the image automatically” to match the image size to the paper size.
Click on “Skip this image” to prevent the image from being printed.
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Whichever solution you choose, you can apply it to all of your images that are too large to be printed
by clicking the box Apply to All Images.
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Exporting

Images that were optimized with StudioLine must be exported to be utilized in other applications such
as word processing or desktop publishing. StudioLine allows you to convert these images to all the
common image file formats and store them on your hard disk or other media.

Open the “StudioLine Explorer” → “Desktop” from the “File” menu. Navigate to the target folder you
intend to store the exported files in, or create a new one. Then, from the Image Archive desktop, drag
all the selected images to be exported into the right panel in the StudioLine Explorer window.

Alternatively, you can start by selecting images to be exported and then right-click to choose “Export
(Save As)” from the context menu.

In both instances, StudioLine opens the “Export Object as…” window. Here you can define details
such as the image size, file format and file name.

Exporting the Original

The option “Export Original” will export the unedited image in the original file format and size. In
addition a XMP sidecar file with the same file name is stored which contains all descriptors and image
tool settings for that image. You will have the choice to enter a different file name. Other settings like
file format and image size are not available.

Saved Settings

You may find that certain projects or certain clients demand specific file formats or sizes. To save
frequently-used settings for easy recall, choose the desired export options and then click on “Save
Settings” near the bottom of the panel.

You can choose an individual name for that particular set of settings.

Later, simply recall the same options from the “Saved Settings” drop-down list by selecting the name
that you assigned to that set of options.

Maximum Image Size

The “Maximum Image Size” drop-down menu offers a choice of standard sizes. The “Use Original
Size” option will export images in the size of the Image Archive originals. You can also use the option
“Custom” to manually set dimensions. A standard or custom size you choose may not exactly fit the
dimensions of the images to be exported. To safeguard against distortion or over-stretching,
StudioLine will never enlarge images beyond their original size or change their width/height
proportions. Instead StudioLine uses the “underfill” technique. The size you choose defines a
bounding rectangle into which StudioLine will proportionally scale the images, as necessary.



2016/02/08 11:06 61/71 StudioLine Photo Basic 4 - English

StudioLine Help - http://help.studioline.net/

The example below illustrates a custom size of 400 by 400 pixels into which a portrait or landscape
image is then scaled in such a way that its longest sides are 400 pixels:

The checkbox “Automatically Adjust for Orientation” will take the orientation of each image into
consideration and assign the larger specified size to the longer side of the image, and vice versa. If
you were to define a size of 640×480 pixels, then a landscape image would be exported 640 pixels
wide, while a portrait image would be 640 pixels high.

Next to the two manual size control fields is a drop down list with units of measurement: pixels,
inches, or centimeter. Images intended for printing or desktop publishing can thus be exported in the
preferred unit of measure. The field “DPI” will activate to let you control the print resolution.

Choice of file format is important for the intended application of the exported image. To use an image
on the Internet, the “JPEG” format with smaller image size is ideal. This format is supported by all web
browsers and uses a highly effective compression algorithm to reduce file size. You can further
individually set the level of compression using “Image Quality” control.

For print or archiving applications on the other hand, best results are achieved with a “loss-less” file
format, such as “TIFF” offers, in combination with a large image size for best resolution.

Other Options

Below the “Format” control you’ll find a list of additional options. Active options are displayed with a
checkmark. Click an option to activate or deactivate it.

Apply Image Tools
If you deactivate this option, StudioLine will keep any pre-processing, but disregard other image
tools, filters, and effects that you may have applied to this image. This allows you to export an
unedited version of your image.
Colorize Transparent Areas
By default, transparent areas (the “alpha channel”) will be exported if the chosen file format
supports transparency (for example TIFF or PNG). Activate this option if you want the
transparent areas to be colored white instead. For graphics formats that don't support
transparency (for example JPEG, BMP), transparent areas will always be exported as white color.
Omit Camera Specific Exif Data
StudioLine will export images with Exif, IPTC, and Windows tags if supported by the chosen
graphics file format. However, certain Exif information would disclose make and model of the
camera, as well as camera settings in effect while an image was taken. If the file format allows
it, select this option to omit any such camera-specific information from the exported file.

Preview/Detail Settings

Click the “Preview / Detail Settings” button to verify the result of your export settings before the files
are actually exported. The preview window will show the image based on all settings and filters, in the
specified size, and, for JPEG images, compression quality as well. It is here that you can set
compression quality and use the sharpen tool. It's easy to find the ideal settings because the preview
will automatically refresh after any change. The toolbar allows you to zoom and choose a preview
size. There’s also an “Adjust Window” button that automatically adjusts the window for preview size
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and aspect ratio.

Images for Web Use:
For web images an important goal is to minimize file size. Choose the JPEG file format and with
the “Image Quality” settings you'll be able to find an optimal compromise between quality and
size.
Images for Print Use:
For images in JPEG format destined to create prints or to be cropped in other applications, set
the preview size to “Scale up to 100%”. Watch the preview window while you experiment with
the “Image Quality” settings until you find the lowest value that does not impact quality.

Path to Export Location

If you launched the export by dragging images to their intended location in “StudioLine Explorer – My
Computer”, then the export path will already be set. Otherwise, or if you want to change the export
location, in the “Export Objects As…” window, click the “Browse” button below the path and navigate
to the folder of your choice. Click the down-arrow in the path field to recall the most recently used 5
export locations from a drop-down list.

File Naming Conventions

By default, StudioLine will use the “Image Name” descriptor value as the export file name. When
exporting more than one image, it is represented by an asterisk. Upon export, StudioLine will
automatically append a sequence number to the name in the new location if multiple images have
been selected bearing the same name. You can simply write over the name if you prefer a different
one. The input field “File Name” has a down-arrow to open a drop-down list offering different options
for automatic file name schemes:

* (Asterisk)
This option, as just discussed, only appears if more than one image is selected for export. It
represents the “Image Name” descriptor value. Choosing this option will use the image names
as file names. If multiple images have the same name, a sequence number will be appended for
uniqueness.
{Number}
This option represents a number corresponding to the order of images in the Image Archive.
You can thus sort images in the Image Archive and export them with filenames that preserve
that order. One application might be a picture CD or DVD that will play images in the intended
sequence on TV. You can add text before or after the “{number}” placeholder in the “File
Name” input field to create more descriptive file names such as: “Vacation {number}” or
“{number} Burgundy”.
{Descriptor}
With this option, the file name is based on the content of an image descriptor. Choosing this
option opens the “Insert Descriptor” panel where you can view and select suitable descriptors.

Additionally, a combination of numbers and descriptors is also possible.

To preview the resulting file name, hover the mouse over the “Path” input field. A tool-tip will show
the export file name for the first image.



2016/02/08 11:06 63/71 StudioLine Photo Basic 4 - English

StudioLine Help - http://help.studioline.net/

Click “OK” to initiate the actual export process.
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Web Galleries

Web galleries are photo albums that you can share with anyone over the Internet or on CD/DVD.
StudioLine generates your web pages complete with navigation links, which can be viewed with all
popular web browsers, then publishes them to the server indicated in your web publishing profile.

Each web gallery you create is structured around an index page showing thumbnail images of all
pictures in that gallery. Clicking a thumbnail image will open a larger view of that same image,
together with any narrative text you may like. Again, the automatic application of descriptors comes
in very handy here. Navigation buttons make browsing to other images in the gallery or returning to
the index page easy.

Creating a Web Gallery

In Image Archive select any number of images, then click the “Create Web Gallery” in the File Menu.

Choose one of the styles listed in the left pane and click on it to preview the gallery’s sample index
page in the right pane. Further information about the selected style is given in the pane at the bottom
of the window.

The hint panel indicates the maximum number of images that can fit on the index page for the
selected style. If necessary, StudioLine will create additional index pages and add the necessary
navigation links between them. The hint panel also identifies which descriptors will be used to display
informational text with each image (see chapter “Working with Images: Adding Descriptions”). Select
your design choice by clicking the “Continue” button.

Web Gallery Settings

This window opens up as the second of four steps during the creation of your Web Gallery. In this
window you can specify various details of your Web Gallery. Note that each Predefined Web Gallery
Style may have different settings. Thus, the style you have chosen may or may not have the exact
options indicated below. However, most of them share a majority of basic features which are
described below. This window is from the Predefined Style 'Modern/Black with Popup and Text'. It is
best to play around with the styles to get a feel for what they can do.

Page Title/Text
This will be the header for your web gallery. It will be displayed at the top of your page of
thumbnails. If you would like a subtitle, be sure to click the indicated box. Enter any other text
and subtext as allowed by this particular gallery style. The text can be revised in a text editor
once gallery has been completed.
URL of the Index Page
This any desired URL which your Web Gallery will provide a link to; e.g. your own web site.
Email address (optional)
Enter an email address if you would like visitors to have a means of contacting you. It is not a
required field for the web gallery.
Generate Link to Map View if Gallery has Geotags
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If you have location based information attached to images, you can create automatic map links
by clicking on this option.
Enable Rollover Effects for Thumbnails
Click on this box if you want to allow rollover effects for your thumbnails. In this particular
Predefined style, a rollover includes a full size image popup.
Images per Page
Indicates the maximum number of images allowed per page for that Predefined Gallery style. If
you exceed the maximum number of images, StudioLine will create more than one index page.
Detail Views/Size of Image View Pages
You have a choice between the size of the enlarged view page, either 640×480 or 1024×768.
Detail Views/Copyright text
Here you can input the copyright for the images that will get displayed.

A line at the top of the window shows where your gallery is being saved. You can click on the
navigation pane to the left to change the subfolder where it is being placed, or you can create a new
subfolder by clicking on the folder icon at the upper right. Type in the name of your new gallery.

After clicking the final “Continue” button, there will be a slight delay while StudioLine generates the
web gallery. Your new web gallery is now saved as a page in a site. StudioLine will then switch to
Page Editor mode to display the result and, if your “Hints” are turned on, you will be given choices on
how to proceed.

You can now work on your gallery pages. Change font, background, margin, etc. by clicking on text or
right-clicking on the background and selecting from the context menu. Refer to the QuickStep Bar for
additional instructions.

Return to the Image Archive via “Photo” in the Main Tool Bar.
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Editing Web Galleries

Once you open an automatically generated web gallery, you’ll notice that some text blocks such as
headlines contain placeholder text. To replace placeholder text with your own, double-click on the
placeholder text. This opens the Text Editor tool for the text block. Type over the placeholder text,
then double-click on the next text you want to edit to open the Text Editor on that text block. Close
the Text Editor by clicking anywhere on the background of the Page Editor workspace.

Return to the Image Archive via “Photo” on the Main Tool Bar.
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Changing and Updating Web Galleries

After editing any images that were used in a web gallery, or after changing the descriptors, you may
want to update the web gallery to reflect your changes. Some web gallery styles also permit you to
revise some of the text passages. In any case, StudioLine will have to re-render the web gallery pages
and transfer a new version to the web server.

Opening an Existing Gallery

Click on “Web” on the Main Tool Bar to open the most recently used web gallery. You may also click
“StudioLine Explorer – Pages” in the “File” menu. This will open an Explorer panel showing all
available web galleries. Rightclick on a web gallery icon and select “Open Page”.

Renaming a Web Gallery

To rename a web gallery, navigate to it in the Navigation pane, ensure that you have clicked on 'Sites'
at the bottom of the Navigation pane to be in the correct mode. Then right-click on the name and
choose Rename. The name field becomes active and you can type in the new name.

StudioLine will ask you if you want to replace the URL of the web gallery with the new name.
Depending on your preferences, click 'yes' or 'no'.

Deleting a Web Gallery

Navigate to the web gallery in the Navigation panel, ensuring you are in the Sites mode. Right-click
and choose “Delete” from the context menu. You can also drag the gallery to the recycle bin.
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Previewing Web Galleries

To preview and test a web gallery to see how it will appear in a web browser, select “Render” from
the “Publish” Main Toolbar Bar icon.

StudioLine will generate the necessary HTML documents. This process may take a few moments
depending on the number and size of images. A message box will advise you when the web gallery
has been rendered. Choose “…browse a preview of the rendered page(s)” to open the gallery in your
computer’s default web browser.

Verify that the appearance of the pages meets your expectations and test the links from the index
page, as well as the navigation between the individual image view pages. If necessary, close the
browser and make adjustments in the StudioLine Page Editor. For another preview, click “Preview”
once again. StudioLine will reopen the browser once the updated web gallery has been rendered.
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Transferring Web Galleries

To view your web gallery on the Internet, it needs to be published from your computer to a public web
server. Sometimes, your Internet Service Provider (ISP) provides free web space as part of your
monthly access charges. Otherwise, you will have to arrange web space (usually for a modest fee on
a per annum basis) with one of the many web-hosting providers available today. Doing an internet
search will bring up the available choices for your area.

Registered StudioLine users receive free web space to test the web gallery features for a limited time
on the StudioLine servers. By utilizing the StudioLine servers to transfer and upload your Web Gallery,
you can be assured that all of your web gallery objects get safely transferred.

StudioLine uses the universally supported “FTP” (File Transfer Protocol) for uploading your files to the
web server. It is strongly recommend that you let StudioLine perform the uploading. StudioLine has
built-in validation to confirm that all new or updated components of your web gallery are uploaded
successfully.

Click “Transfer” from the “Publish” Main Tool Bar icon.

Publishing Profile

The “Edit Profile” panel opens – either as an empty form or with information you previously entered.
The information in the publishing profile enables StudioLine to contact the web server and transfer
your gallery. StudioLine uses the same publishing profile for all of your web galleries.

Constructing your Publishing Profile

The information to fill out the publishing profile is obtained from the provider of your web space.
Usually, you’ll only need to fill in the fields FTP Server, Login/User, Password, and the “Root URL”. The
remaining fields can remain at their default values. If your provider does not specify a separate FTP
server, then it may be the domain name of your web site (for example “www.YourDomain.com”) and
the URL of the web site root would be “http://www.YourDomain.com”.

To upload your pages to specific folders on your FTP server, specify the “Remote Directory”. If the FTP
folder translates to a corresponding folder on your web space, then append the folder name to the
URL of the web site following a forward slash, for example a remote directory of “MyFolder” would be
represented in the URL as “http://www.YourDomain.com/MyFolder”. The name of the “Default
Document” is server-specific, usually “default.htm”, “index.htm”, or “index.html” and can be obtained
from your web-hosting provider. StudioLine requires this name to generate proper names for your
pages. If you are unable to obtain the name, StudioLine will attempt to determine that name for you
while testing the publishing profile (see below).

The number of “Maximum Concurrent Connections” tells StudioLine, how many parallel FTP sessions it
may open in an attempt to maximize bandwidth and reduce total upload times (possibly reducing
your connection fees.) Some providers do not permit more than one connection. StudioLine will
attempt to determine the maximum number while testing the publishing profile.
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Sometimes workstations are running behind firewalls or have personal firewall software installed to
avoid intrusions by unauthorized parties. Depending on the firewall technology and configuration, it
may be necessary to specify a “Proxy Server”, a “Port”, or to select the option “Passive”. Your local
system administrator will be able to assist you with the correct configuration.

After filling in the profile, click the “Test” button. StudioLine will connect to your web server to test
and verify your settings and make any corrections as needed. If the test fails and StudioLine cannot
determine the correct settings, then an error message will indicate the specific circumstances.

It is possible that your web server requires less common settings for “Remote Directory”, “Root URL”,
and “Default Document”, which differ from the above examples. In that case, you will need to contact
your web-hosting provider for the correct information.
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Exporting Web Galleries

Web galleries may be exported for backup purposes or be copied to other StudioLine workstations.
This process is similar to the one documented in the section “Export as StudioLine File”. From the
Menu Bar item choose “File” → “Export” → “StudioLine File”.

In the Panel “Choose Objects to Export” click on “Pages”. To export all web galleries click “OK”
without selecting a specific gallery. To export individual galleries select one or multiple web galleries
in the right pane. Remember that you can select multiple non-consecutive galleries by holding down
the “Ctrl” key while clicking.
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